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Software Overview
The screenshot at right is a typical
SpectralWorks screen. The elements of the
application window are described below and
are exploded and labeled on the next page.

TITLE BAR
The Title Bar contains the program name as well as
the current data collection modes (if an instrument is
present). The control buttons on the right hand side
of this bar will close, minimize or maximize the
program.

MENU BAR
Menus located in the Menu Bar are used in data
analysis.  Changes in how data are viewed, fit or
printed are located here. The control buttons on the
right hand side of this bar will close, minimize or
maximize the dataset currently being viewed.

TOOL BAR
The Toolbar contains shortcuts from the menu bar. This
bar contains several smaller toolbars, which indicate from
which menu the shortcut is derived from. From left to
right these are File (open and saving files), Edit (cutting
& pasting, as well as dynamic slicing), View (Hiding
data and 3D views), Fits (SVD fit), and Data Collection
(Initiate data collection if an instrument is present).  

DATA COLLECTION TABS
(DATA COLLECTION ONLY)
The data collection portion of the software is divided into
five (or more) tabs. Each of these tabs displays information
about an aspect of data collection. The content of these
tabs is dependent on the type of instrument that the
software is running. The content of these tabs is described
in detail later in this manual. 

INSTRUMENT SETTINGS 
(DATA COLLECTION ONLY)
All user changeable instrument settings are located here
in this region of the screen. The contents will vary with
instrument type and what tab is currently displayed.
Detailed information on these settings is located later in
this manual.

DATA DISPLAY (DATA COLLECTION ONLY)
Current data are displayed graphically in this area. After
data are collected they are transferred to the Experiment
Window for analysis. The current status of the instrument
is updated in the upper left hand corner of this window.

STATUS BAR (DATA COLLECTION ONLY)
In this region information such as elapsed time of current
scan and current scan speed are displayed. 

EXPERIMENT WINDOW
Every open window, including the data collection
window, is listed here. When a dataset or fit is generated,
an icon is created in this window. Move between
windows by clicking on the icons in this window
("Ctrl+tab" is the keyboard shortcut). The highlighted
dataset is the one currently being displayed.

PROPERTIES WINDOW
This window lists properties of the current dataset being
displayed, such as number of data points, data collected,
and dataset name. The dataset name can be changed here
by double clicking on the name property and entering the
new name.
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File
NEW EXPERIMENT
This option allows you to
create a new experiment,
which will consist of
protocol and dataset files.

OPEN EXPERIMENT
Open a previously saved
experiment  (*.ole or *.olg).

REMOVE DATASET
This option allows you to
remove/close the active
dataset. The name of the active dataset in this case was
PROTFOLD. The active window is also indicated in the
experiment window as well as in the windows title bar
along the top margin of the window. 

STARTUP
Select this option to view the initial startup. From here
convenient windows exist which allow access to existing
files, recently opened files, and tutorials. 

OPEN / OPEN DATASET
This option allows you to open a previously saved dataset.

SAVE DATASET
Select this option to save the currently active dataset. 

SAVA DATASET AS...
This option allows for the current dataset to be saved
under a different name or in a different directory. 

EXIT
Choose this option to exit the GlobalWorks program. 

Edit
COPY SLICE
Use this option to select a slice
from among many in an active
2D dataset. Once the cursor is
active, selecting copy slice from
the edit menu with designate that
slice as the one to be copied.
Once a slice has been selected for copying, the selected
slice can be pasted into a different dataset with the same
collection mode (i.e. absorbance vs. wavelength,
absorbance vs. time, etc.)

PASTE SLICE
This option becomes active only after you have selected a
slice and applied to “Copy Slice” option from the edit
menu. The slice is then available from the clipboard to be
pasted into a dataset with the same collection mode. 

REMOVE SLICE
This option is used to remove any slice from an active
dataset. NOTE: In order to make a removed slice visible
again, the scan’s number must be entered into the third
box of the index column of the Selected Data Parameters.
To activate this table, click the cursor on any slice. 

LOCK ON SLICE
Once the cursor is active you may select this option from
the Edit Menu and the cursor will lock on this slice.
Moving the cursor allows you to travel along the selected
scan exclusively. Information about the 'locked on' slice
will appear dynamically in the parameter table.

DYNAMIC SLICING
This option is available only in the 2D view. By selecting
a scan from the collected data and then performing
dynamic slicing, a slice of the scan at the selected
wavelength will be displayed in the right graph. 

View
TURN DATA
CURSOR OFF
Once a slice is selected
and the cursor
(crosshairs) appears
deactivation requires the
selection of this option. 

2D VIEW
This options allows the
viewing of a three
dimensional file
(typically an *.sc3 file) as a two dimensional file with
selected scans on the left and a slice thru the data at some
wavelength on the right. 

3D VIEW
This option allows for the viewing of a  2D dataset as a
three dimensional image.  The 3D graph created can then
be manipulated (rotated, rescaled, etc.).

HIDE SLICE
When the data cursor is active on a slice, this option allows
you to hide (remove from display) the selected slice.

Menu Bar Descriptions
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MENU BAR DESCRIPTIONS

UNHIDE SLICE
When this option is selected all previously hidden slices
will reappear. If multiple scans were hidden, all will
reappear simultaneously. 

SWAP HIDDEN/UNHIDDEN SLICES
This feature allows you to swap visible slices with slices
that you have previously hidden with the hide slice
option.

LOGARITHMIC AXIS (X-AXIS)
When you select this option the program calculates and
displays the Log to the base 10 (Log) of the x-axis.

LOGARITHMIC AXIS (Y-AXIS)
When you select this option the program calculates and
displays the Log to the base 10 (Log) of the y-axis.

EXPERIMENT WINDOW
All open windows for the active experiment(s) are listed
in this window. Selecting a file from the list makes this
selection the active window. This option allows you to
view/hide the experiment window.

PROPERTIES WINDOW
The parameters of the active window are displayed. The
parameters include name, data, type, full path, etc. This
option allows you to view/hide the experiment window. 

Fits
SVD
Factor analysis is a
multivariate statistical method
for extracting the information
content from a dataset. In the Olis case we have a large
matrix consisting of absorbance, etc. as a function of both
wavelength and time. Factor analysis, in the Olis case
singular value decomposition (SVD), reduces this to 3
smaller matrices that contain all the information present
in the data. The kinetic information is contained in a
kinetic eigenvector matrix. Experience has shown that
only a small number of eigenvectors are needed to
describe the data. Olis uses 6. The various rate processes
are stored over a small number of eigenvectors and a
kinetic model may be fitted to those to extract the rate
constants. Similarly the spectral information is stored in a
set of 6 eigenvectors. Finally a vector of singular values
is produced. Typically these start off at a high value and
fall off rapidly to a value near zero. The number of
singular values above zero is an indication of the number
of species significantly present in the data and is useful
for model selection.

A representation of the original data may be obtained by
a suitable matrix multiplication of the 2 eigenvector sets
of vectors and the singular values. This reconstruction is
the original less most of the noise. Thus, the processes of
SVD and reconstruction smooth the data. The 3 matrices
are commonly used to store the information in the data in
a much more compact form than the original;  about 30
times smaller. It is also much easier to do the global
kinetic fit on the compact kinetic set than the original
large data set. Thus factor analysis cleans up the data,
affords more compact storage, and greatly reduces the
scale of the global fitting problem.  
SVD is one of several methods for factor analysis and is
generally recognized as being the mathematically most
robust. The Olis modifications to SVD in no way modify
the way in which it is used or the conclusions drawn
from it. The only difference is a large gain in speed.

SVD ON DATA SUBSET
Use this option to perform SVD on a data subset. 

2D FITS
Olis GlobalWorks software provides multiple
mechanisms for fitting single kinetic traces. 

COMPTON FIT
Choosing this option after clicking on a circular dichroism
scan allows for prediction of protein secondary structure
based on the algorithm described in Compton, L. A., and
Johnson, C. W. (1986) Anal. Biochem. 155, 155-167.
In order for this option to provide valid results data must
be collected in the prescribed way shown below. 
Four variants are possible:
41 pts      260 to 178 nm        39 pts      260 to 182 nm
40 pts      260 to 180 nm        38 pts      260 to 184 nm

VARIABLE SELECTION FIT
Choosing this option after clicking on a circular dichroism
scan allows for prediction of protein secondary structure
based on the algorithm described in Johnson, C. W. (1999)
Proteins: Structure, Function, and Genetics 35, 307-312.
This method differs from the Compton fit in that it uses
eight basis spectra which are extracted from a set of
twenty-six spectra of known proteins. The spectra are
selected to be those which most resemble the spectrum to
be fit, which must be from 178 nm to 260 nm and contain
one point per nm (83 points).
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MENU BAR DESCRIPTIONS

Tools
DATA
PROCESSES
The data processes
listed under the
Tools menu are
identical to those
described on the
Data Processing Menu page.

RECONSTRUCT 3D FROM SVD DATA
This option utilizes the eigenvectors to produce a 3D
dataset similar to the original data (source of the SVD
eigenvectors) but with much of the noise removed.  Click
here to see an illustrated example.

RECONSTRUCT 3D FROM 2D DATA
This option allows for the conversion of a 3D data file
(*.sc3) to a 2D data file.

CREATE DATA SUBSET
By entering new wavelength and time values, a subset
suitable for fitting can be created from the original data;
this facility will be used if one wishes to 'trim' a dataset
which may contain data deemed unsuitable for fitting.

DATASET REPAIR
This option is used to remove an errant data point, which
may be affecting a kinetic fit. Once a questionable data point
(or region) has been selected, the data will be replaced by an
average of a user-selected adjacent data region.

OPTIONS MENU
Choosing this option opens a form with the following
three tabs:
Report Options: Use this page
to change the default color for
printing to black and white or to
choose whether or not to print
the data cursor on the graph.
SVD Type: Choose between the
Matheson SVD algorithm,
which utilizes wavelength
compression, or the original
Golub-Reinsch (Golub G.,
Reinsch C. Singular Value
Decomposition and Least
Squares Solutions, in Wilkinson
J.H. and Reinsch C.(editors)
Handbook for Automatic
Computation, vol II.Springer.
1971.)  algorithm. The
Matheson method uses matrix

exponentiation (Zamis, T. M., Parkhurst, L. J., and
Gallup, G. A. (1989) Computers in Chemistry, 13, 165-
171.) and is significantly faster than the original
algorithm. The default type uses a either algorithm
depending on dataset size. The Matheson technique is
more appropriate for large datasets (>10,000 points).
SVD Data Display Options: The two options available
for SVD data display are the Olis square root display and
the conventional display. This option changes the SVD
Eigenvector display only, and has not effect on the data
itself. In the Olis display, spectral data are presented as the
square root of the eigenvector value, which serves to de-
emphasize the spectral component of the eigenvector and
reduce the potential or inclusion of spectral artifacts into
the fit. For this reason, this display is the default display.

Chart
RESET CHART
This option allows the
restoration of the active chart to
its original condition (i.e.,
unhides hidden slices, resets
zoom or scaling, etc.).

RESET ALL CHARTS
This option allows for the restoration of all active data
charts to their original condition (i.e., unhides hidden
slices, resets zoom or scaling, etc.). 

ZOOM
To activate the zoom function you must be viewing 2D
data and the cursor must be active on a slice. Clicking
and dragging your mouse cursor allows you to create an
outline of the data which once zoomed in on will
consume the entire area designate to the data screen. To
undo this function select reset chart from the chart menu. 

SCALING
When this option is activated the active chart can be
rescaled in its window using mouse movements.   

PRINT CHART
This option allows for the printing of the chart actively
selected by the cursor. 

COPY TO CLIPBOARD
Once this option is selected a copy of the active dataset is
saved to the clipboard which can then be pasted as an
image file to any program which allows the
importation/pasting of an image file from the clipboard.
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MENU BAR DESCRIPTIONS

Help
TUTORIAL
MATHESON-DESA
FITTING TUTORIAL
This option allows you to
activate an interactive
tutorial guiding you step
by step through applying
global fit to your data set.

CONTENTS
Access the help index. 

OBTAINING TECHNICAL SUPPORT
This option allows you to email your technical concerns
directly to Olis’ technical support department at
techsupport@olisweb.com. 

OLIS, INC. ON THE WEB
If you have an internet connection, this option sends you
to our website, www.olisweb.com. 

REGISTER SOFTWARE
After your trial has ended you can select this option to
purchase GlobalWorks software and receive your
registration number and unlock key. 

ABOUT
This screen contains information about the software
including your version number, trial expiration date, and
registration information. 
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SLITS
This feature is unique to the DSM 17 CD, which
supports computerized, variable slit width during
scanning. When the Scan Mode is set to Fixed PMT HV,
then this value is for display only. When the Scan Mode
is set to Fixed Slit Width, then slit width is fixed at a
user specified value. When the Scan Mode is set to
Fixed Bandwidth, then the bandwidth is fixed at a user
specified value with slits adjusted to compensate for
dependence of bandwidth on wavelength.
See page 11 for more information on changing the Scan Mode.

CURRENT WAVELENGTH
The wavelenth position of the
spectrophotometer is reported and
changed here. During a scan, the
wavelength changes, so this
number is dynamically updated 
on the screen. 
To change the wavelength, click on
the value and enter a new number.
The wavelengths available for use
are monochromator specific. 
Standard ranges for Olis CDs are:
DSM 10 CD: 170-700 nm 
DSM 17 CD: 185-900 nm
(extendible into the NIR)
DSM 1000 CD: 167-450 nm
(extendible into the NIR) 
The keystroke shortcut for changing the wavelength is W.

SCAN RANGE
Starting and ending wavelengths for the desired scan are
entered and displayed here. The range for these values is
the same as that for the Current Wavelength (see above).
The keystroke shortcuts for entering the starting and
ending wavelengths are F and T, respectively.

Start-Up Display
This display appears at startup and contains 
shortcuts for opening files and instrument setup. 
Identical on all Olis programs.

EXISTING
Select this tab to open a dataset or experiment already
acquired and stored.
DATA COLLECTION
Select this tab to open a data acquisition mode to start
using the spectrophotometer.
TUTORIALS
Select this tab to open the tutorial on Global Fitting.

Live Display
Displays current instrument 
settings and collection data. 
Instrument specific, yet largely 
identical on all Olis programs
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NUMBER OF INCREMENTS
The number of increments to be collected in each scan or
assay is entered here.
The keystroke shortcut for entering 
Number of Increments is N.

CURRENT SCAN NUMBER
If multiple scans are to be collected, the current scan and
total scan numbers are displayed here.
See page 13 for details on setting up repetitive 
scans or assays.

INTEGRATION TIME
The time spent collecting each datum is displayed and
changed here. This value can be user specified or
determined empirically based on the available light levels. 
The keystroke shortcut for changing Integration Time is I. 

CURRENT SAMPLE TEMPERATURE
If the instrument is equipped with an active temperature
controller, the Current Sample Temperature is
displayed and changed here. This value is updated when
the instrument is in Live Mode and during data
collection. This is the bath or Peltier cell temperature
unless the controller is equipped with an external
temperature probe.
See page 29 for temperature controller options, and 
page 13 for setting up and using a temperature script.

RAW PMT SIGNALS
The raw PMT signals in volts are recorded in real time
here. The signals are color-coded to correspond to the red
and blue bands on the photomultiplier tubes.

LIVE CD DISPLAY
The current CD signal is reported here and is updated
dynamically when in Live Mode. The units are identical
to those shown in the chart.
See page 16 for details on changing the reported CD units.

=  # of INCREMENTS +1NUMBER 
OF POINTS

LIVE DISPLAY

CURRENT PMT HV
The current PMT high volts (HV) are shown here. This
value is adjusted automatically in Live Mode and during
data collection to keep the PMT signals near 2 volts,
where optimal signal/noise is achieved. These values are
directly related to the intensity of light hitting the
detectors; higher voltages indicate low light levels. This
value will range from 200-1100 V, and will read 0 when
PMTs are off.
Warning Note: To avoid damage to PMTs, make sure they
are turned off when the sample compartment lid is
removed or in any case that the PMTs are exposed to an
undesirably high level of light.

MANUAL PMT HIGH VOLTS CONTROL
This feature turns on or off the high volts (HV) to the
photomultiplier tubes when Manual High Volts is
selected as a detector option in the Operations Mode
tab. In this mode, the PMTs must be turned off with this
switch before they are exposed to room light.
See page 11 for more information on the 
Operations Mode tab.

APPLY BASELINE
This box is checked when a baseline is applied to the data.
Once a baseline is selected the number of data points and
scan range cannot be changed without deselecting the
baseline. To undo a baseline, uncheck this box by
clicking on it.
See page 20 for more information on assigning a baseline.

LIVE MODE
Click on this button to enter the instrument into Live
Mode. In this mode, the PMT high volts are adjusted and
data are collected but the data are not stored. Displays
such as current CD intensity and current sample
temperature are updated continuously.  
Exit Live Mode by pressing the Escape key on the
keyboard. It is recommended that this mode be exited
before performing data analysis or exiting the program.
The keystroke shortcut for entering Live Mode is V.
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LIVE DISPLAY

COLLECT DATA
Click on this button to begin data collection. In Scan
Mode, CD data will be collected as a function of the
wavelength range entered in the starting and ending
wavelenths for the scan. With the Data Collection Mode
set to Scan, the instrument will scan the number of
points from start to finish. With the Data Collection
Mode set to Assay, the data will be collected at a fixed
wavelength as a function of time.
See page 11 for details on changing the collection mode.
The keystroke shortcut for Collect Data is D.

AUTO ADJUST HV
This button causes the PMTs to adjust high volts to give a
PMT signal around 2 volts. No data are collected.
The keystroke shortcut for Auto Adjust HV is U.

STOP/ ESC
Clicking on this button or pressing the Escape key exits from
Live Mode. If pressed during data collection, the current
assay or scan is terminated and the instrument goes into Idle
Mode, in which the truncated dataset can be retained.
Note: If the Manual HV Shut Off check box in the
Operational Modes tab is not selected, then the PMT
HV will automatically shut off when exiting Live Mode.

POST THESE DATA
Clicking this button stores the data only in memory and
not on the hard disk. Posted data are transferred to data
processing, where they can be manipulated, fitted, or saved
to a disk. Data that are not posted will be overwritten when
new data collected. The option to post data will also be
given in a prompt at the end of data collection.
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Operational Modes
Displays current data collection
and data reduction modes.
Contains additional options.

DATA REDUCTION MODE
Data are displayed as Circular
Dichroism  (Absleft-Absright). For
diagnostics, change from CD to
Raw Signals, gaining complete
control over the PMT high volts
and slits, and obtaining a raw
PMT output.
See page 16 for details on how to
change CD units.  
The keystroke shortcut to change
the Data Reduction Mode is R.

DATA COLLECTION MODE
The option of taking scans, assays or stopped-flow data is
given here. Scans are taken as a function of wavelength.
Individual or repeated scans can be taken as a function of
time, temperature or another variable. 
Assay data are taken at a single wavelength as a function
of time. When the Data Collection Mode is set to
Assay, the total time of assay is changed in the Live
Display tab.
The stopped flow mode also collects data as a function of
time and requires a stopped-flow apparatus to function.
Note that single point data can be obtained by setting this
to Assay and Number of Points to Collect to “1” in
the Live Display tab.
See page 8 for more information on the Live Display tab.
The keystroke shortcut to change Data Collection Mode is C.

DETECTOR OPTIONS
Selecting Manually Shut Off HV gives the user
complete control over the PMT when in Live Mode.
When this option is not selected, the PMT is under
computer control and turns off at the end of each scan.
Unchecking this option is the safest mode for PMTs as it
prevents damage due to saturation.
If the user prefers that the PMTs remain on when the
instrument is not collecting data, this option should be
checked. In this mode care must be taken to avoid exposing
the PMTs to room light while a PMT HV is applied. 

Selecting Reverse Beam Mode switches the sample and
reference beams such that the reference chamber can be
used as the sample chamber.

SCAN MODES
Because the DSM 17 CD has the choice of variable slit
widths during data acquisition and the Olis DSM 10 and
1000 systems do not, not all three scan modes are
supported on all three DSM CD instruments.  
Constant Bandwidth: In Constant Bandwidth Mode, the

slit width is changed to maintain a constant bandwidth,
while the PMT HV are adjusted to compensate for light
intensity changes. This mode is unique to the Olis DSM
17 CD, and is the most commonly used mode.

Fixed Slit Width: In this mode, the slit width stays fixed
and the PMT HV is changed to compensate for changes
in light intensity. This is the only mode available for the
DSM 10 and DSM 1000; it is also available for on the
model 17.

Fixed PMT HV: In this mode the PMT HV remains at a
user-specified fixed value, while the slits adjust to
compensate for light intensity changes. This option is
unique to the DSM 17. In the DSM 10 and the DSM
1000 slits are not adjustable and this mode will result in
no compensation for changing light intensities
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OPERATIONAL MODES

TIME UNITS
This option changes time unites for data collected as a
function of time. Hours, minutes, seconds, or
milliseconds are available.

INTEGRATION TIME OPTIONS
Constant or Variable integration time are available, where
"integration time" is the time used to collect each
retained datum.
Constant Integration Time: The option fixes the time

spent collecting data for each point at a user-defined
value (see page 3 for details on changing this value).
This mode is useful when a fast scan is required. That
is, S/N can be abandoned in favor of obtaining a
exploratory scan.

Integration Time as a Function of High Volts: In this
mode, the integration time for each point is calculated
as a function of PMT high volts. Integration time
increases exponentially with increasing PMT high
volts. Thus, more time is spent collecting data at
wavelengths with the lower light intensity, normally
below 220 nm. A protein scan, from 260-180 nm say,
should always be done in this model to achieve a
relatively constant signal to noise ratio from start of
scan to end.  

END OF SCAN OPTIONS
This choice determines whether the monochromator
returns to the start position after a scan or remains at the
end position. Stop at the end of scan is used when the
sample is photosensitive.

WAVE UNITS
Choose between data being reported in wavelength (nm)
or wavenumber (cm-1).
When Wavelength is used, the values run left to right
high wavelength to low (e.g., 400-300 nm).  
When Wavenumber is used, the values run left to right
low value to high (e.g., 41000 to 22000 cm-1).
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Repeated Scans
Allows collection of multiple
scans or assays in a single
dataset.

NUMBER OF SCANS
Enter the number of scans or
assays to be repeated here. After
they are acquired, all of these
scans will be included in a single
3-D dataset for storage and
subsequent handling.
The keystroke shortcut for entering
the number of scans is N.

REPEAT SCANS AS A
FUNCTION OF
Repetitive scans can be collected
as a function of None, Time,
Temperature Script, or
Titration Script. In rapid
scanning mode these options are not available.
None: Scans are collected consecutively, as quickly as

possible, without pause. This is a useful mode for
averaging several scans. See page 14 for more
information on averaging scans.

Time: Scans are equally spaced out over the designated
amount of time. The incubation period between scans can
be skipped by pressing the spacebar, with the remaining
scans being spaced out over the remaining time.

Temperature Script: When repeated scans are acquired
as a function of temperature (either by water bath or
Peltier cell), an Olis script is used. The instrument will
automatically adjust the temperature, incubate a
prescribed amount of time and collect data when Collect
Data is clicked in the Live Display tab. The resulting
scans will be presented in a 3-D dataset with wavelength,
temperature, and signal intensity as the three axes. The
script is selected and edited with the Edit Script button.
The instrument must be equipped with a water bath or
Peltier cell that is compatible with Olis software. See
page 27 for a sample temperature script.

Titration Script: To use this option the instrument must
be equipped with an Olis titrator. In this mode additions
of titrant are made automatically between scans or
assays.  The resulting dataset is a 3-D data set with
wavelength, concentration, and CD intensity as axes.
The script is used and edited as described. The Titrator
Control Panel also becomes active when this mode is
selected. See page 25 for a sample titration script.

TOTAL TIME FOR SCANS (UNITS)
This option is active when Collect Scans as a Function
of Time is selected. The program will compute the
required wait time between scans, so as to give equal
intervals between scans or assays. If a time is entered that
is less than the amount of time required to complete the
scans, they will be collected as fast as possible (i.e., no
wait time between scans). This option is disabled when
collecting in rapid scanning mode.
See page 12 for more information on changing the time
units in the Operational Modes tab.
The keystroke shortcut for changing the 
total time for scans is T.

SCRIPT NAME
This display shows the location of the current active
script file. A new file can be selected by clicking on the
filename and entering in the new file. Alternatively,
pressing 'Browse' allows the user to open the new script
file. Script files have the extension .osf.
See page 31 for a sample titration script file.

OLIS DSM CD SOFTWARE MANUAL 13



EDIT SCRIPT
The current active script can be edited by clicking on this
button. Changes in the script must be saved (under the
File menu) before exiting. The script can also be edited
using the program Notepad, which is included in
Microsoft Windows. Note: Do NOT use Wordpad or any
other word processing software to change the script. This
may corrupt the script file format.
See page 31 for a sample titration script file.

SCAN METHOD
Choosing Auto causes the intrument to operate entirely
without user intervention. When a script file is being run,
this option is automatically set to Auto.
Selecting Manual results in a pause between each scan
durring which time the space bar must be pressed in
order for data collection to be resumed. This method is
useful if the sample nas to be manipulated between scans.
The keystroke shortcut for setting the 
Scan Method to Auto is A.

AVERAGE SCANS
Selecting this option will automatically average all scans
into one 2-D scan as the final result. If this option is not
checked, the data can be averaged later. Choosing to
average scans cannot be undone, as only the average is
saved, not the raw data.
The keystroke shortcut to activate Average Scans is R.

SHOW MANUAL CONTROL FORM
This button is enabled when repeat scans or assays are
collected as a function of titrator or enzyme assay script.
Pressing this button shows manual control form to
control the syringes. Note: the titrator will calibrate when
this button is pressed.
See page 30 for more information on the 
Titrator Control Panel.

REPEATED SCANS
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X & Y Axes
Options for editing the axis
scale and displaying colors.

X-AXIS
This option changes the scale of
the X-axis during data collection.
The data are not affected by
changing this scale; only the
display is affected.
The keystroke shortcuts to access
the X-axis minimum and maximum
values are M and A, respectively.

Y-AXIS
This option changes the scale of
the Y-axis (the fluorescence intensity) during data
collection. The data are not affected by changing this
scale; only the display is affected.
The keystroke shortcuts to access the Y-axis minimum and
maximum values are N and X, respectively.

AUTO SCALE Y-AXIS
This option allows the graphic to be automatically scaled
continuously during data collection. This is particularly
useful if the user does not know the amplitude of the
expected signal.
The keystroke shortcut for selecting Auto Scale Y-axis is O.

Y-AXIS (RAW DATA)
This option changes the scale of the raw signal of 
the PMTs. This signal can be accessed by double clicking
on the graph, during data collection. The data are not
affected by changing this scale; only the display is
affected.
The keystroke shortcuts to access the Y-axis minimum and
maximum value are I and S, respectively.

AUTO-SCALE (RAW DATA)
This option will allow the raw signal graphic to be
automatically scaled continuously during data collection.
This is particularly useful if the user does not know the
amplitude of the expected signal.
Pressing keystroke for activating Auto Scale Raw Data is U.

CHANGE LINE COLOR
This control allows the user to change the line color
during data collection. Up to nine different colors can be
used from a palette of hundreds of colors.

CHANGE BACKGROUND COLOR
This control allows the user to change the chart background
color during data collection. Up to nine different colors can
be used from a palette of hundreds of colors.
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HARDWARE RESET AND
CALIBRATION
Clicking this button will result in
calibration of the monochromator
and any other associated motors.
Recalibrating should be performed
if any problems are encountered.
Contact Olis if problems persist.  
The keystroke shortcut for Hardware
Reset and Calibration is R.

GET VERSION
INFORMATION
This button allows reading of the current hardware
versions on your instrument. This information can be
very useful when receiving technical support from Olis.
The keystroke shortcut for Get Version Information is G.

ACTIVE DATA COLLECTION DEVICES
All available detectors are listed here and active detectors
are designated with a check. Both PMTs must be active
for the correct CD to be collected.

DUTY CYCLE
The duty cycle of the photoelastic modulator indicates
the percentage of time spent using left circularly
polarized light. If this value deviates by more than 5%
from 50%, an error message will be given in Live
Display. Contact Olis if problems persist.

CD UNITS
Choose from the following available CD units:
Absorbance (DA): The basic units of CD are absorbance

which are derived directly from Absleft-Absright.
Milliabsorbance (mDA): These are 1000-fold smaller

than absorbance units and are commonly used because
CD signals are typically quite small.

Ellipticity (q): Units of ellipticity are given in degrees
and are related to absorbance units by q=32.98DA.

Millidegrees (mq): Millidegrees are the most common
units of ellipticity used for CD. These are 1000-fold
smaller than degrees.

Molar Ellipticity ([q]): Molar ellipticity is normalized for
sample concentration. Sample information must be
entered by the user below the units. The concentration
(g/L), cell pathlength (cm), and mean residual weight
(g/mol) must be entered by the user on this screen. The
units of molar ellipticity are deg cm2/dmol.

RECOVER SAFE DATA
A backup of each dataset is created after each data
collection. Upon normal exiting of the program, these
files are erased. In the event of a power failure or other
disruption of data collection, previously collected data
can be restored by clicking on this button and selecting
the desired dataset to restore.

Parameters
Contains instrument controls
such as number of active
detectors, current CD units,
and photoelastic modulator
duty cycle.
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PROPERTIES WINDOW
This window lists properties of the file being displayed,
such as number of data points, date collected, and data
set name.
The data set name can be changed here by double
clicking on Name and entering in a new name followed
by the return key. This is not the file name, but only a
name for display that will be saved with the data.
Data can be saved by selecting Save As under the File menu

2D Data Display
Data display for 2-D datasets.

COMMENTS
This section allows for the user to
add comments that will remain
with the file when it is saved. After
data collection, useful instrument
settings will be reported here.

SELECTED DATA
PARAMETERS
This table indicates the location of
the cursor, which can be activated
by clicking on the data. 
The X and Y values are recorded
under Absorbance and
Wavelength. None refers to the
fact that there is no third axis (i.e.
the data is 2-dimensional).  
The Index column refers to the datum number of the
data set. Only independent variables will have an index
value (e.g., time, scan number, wavelength).

EXPERIMENT WINDOW
Every open window, including the data collection window
(not shown above) is listed here. When a new data set or
fit is generated, a new entry is added to this window.
Move between windows by clicking on the data sets in
this window. To delete a window, make it the current
window, and click in the lower X in the right corner.  
The dataset name, which can be changed in the Properties
Window, is followed by the filename in parentheses. Data
are not saved if file name is not present.
Datasets can also be selected for data processing here by
right clicking and choosing Select. The data processing
options become active in the right click menu. Among these
options are arithmetic, smoothing, and averaging of data.
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3D Data Display
Data display for 3-D
datasets.

2-D DATA VIEW
Pressing this button displays the
3-D data as two 2-D slices. In this
case one graph would have
overlayed spectra and the other
has the kinetic trace at one
wavelength. This option is also
available under the view menu.
See page 19 for more information
on 2-D Data Display.

SVD
This button initiates analysis of the
data using the Singular Value Decomposition algorithm.
This process can be used to globally fit 3-D data or as a
noise filter for the data. This option is also available under
the Fits menu. A tutorial on SVD is available in the Start-
Up Display. 
See page 8 for more information on the Start-Up Display.

DATA
The number of scans to be displayed are changed here. A
step of “1” shows all data up to 200 scans.

SCALE
Clicking this option allows the axis scales to be changed.
Autoscale is also available.

ROTATION
Clicking this option allows the view to be changed.
Degree rotation of axes can be entered or the graph can
be dragged after checking the Rotation box.
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2D Data Display (Multiple Trace)
Displays datasets as 2-D
slices. Allows simultaneous
view of overlayed spectra and
kinetic trace 

LOCK ON SLICE
Once the cursor is active by
clicking on data, you may select this
option to lock on a particular slice
of data. Moving the cursor allows
you to travel along the selected scan
exclusively. Information on the
“locked on” slice will appear
dynamically in the Selected Data
Parameters window. This option is
also availableunder the Edit menu.

DYNAMIC SLICING
Clicking on this button after selecting a scan from the
collected data will dynamically display slices at the
selected wavelength in the other graph. This option is
available only in the 2-D view. This option is also
availableunder the Edit menu.

REMOVE CURSOR
Once a slice is selected and the cursor appears, this
button will deactivate the cursor. This option is also
availableunder the View menu.

HIDE SLICE
When the data cursor is active on a slice, this option
allows you to remove from display to a hidden clipboard.
This option is also availableunder the View menu.

UNHIDE SLICE
When this option is selected all previously hidden slices
will reappear. If multiple scans are hidden, all will
reappear simultaneously. This option is also availableunder
the View menu.

SWAP SLICES
This feature allows you to swap visible slices with slices
that have been hidden with the Hide Slice option. This
option is also available under the View menu.

3-D VIEW
This option allows viewing of the 3-D datasets as a 3-D
image. The 3-D image can then be manipulated. This
option is also availableunder the View menu.
See page 18 for more information on 3-D Data Display
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Data Display Options Menu
Right-clicking on a scan brings
up these display options.

SCALING
To change the scale of either the X
or Y axis, select this option.  A
window will appear to prompt the
new scaling values.

AUTOSCALE
Choosing this option causes the X
and Y axis to be autoscaled.

SAVE AS ASCII
This option allows for a 2-D
dataset to be exported as a two
column, tab-delimited ASCII text
file with no headers or footers.  
If this option is selected for a 3-D dataset, the highlighted
2-D dataset will be exported.

EXPORT DATA TO EXCEL
This feature will open the current data set (2-D or 3-D)
into Microsoft Excel as a spreadsheet. Micrososft Excel
must be installed on the computer for this feature to work.

ASSIGN AS OPEN
Clicking this option assigns the highlighted scan as the
“open” scan for scan correction. The “open” scan should
be a scan with no sample in the beam and should ideally
give a 100% transmission. 

ASSIGN AS BLOCKED
Selecting this option assigns the highlighted scan as the
“blocked” scan for scan correction. This scan is taken with
the shutter closed and should ideally give 0% transmission.

ASSIGN AS BASELINE
Selecting this option will cause the highlighted scan to be
assigned as a baseline, causing this dataset to be
subtracted from subsequent measurements. “Baseline”
will appear in the Live Display and the Apply Baseline
checkbox will be checked. Data collected must be equal
to the baseline in number of points and scan range in the
Properties window.
See page 9 for more information on the 
Apply Baseline checkbox.
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Data Processing Menu
All data processing steps are
given in this menu. The
highlighted dataset must be
selected for this menu to
become activated. This menu
is also available under the
Tools menu.

SELECT
To select a dataset:
• Highlight the desired dataset by

left-clicking on it in the
experiment window.

• Right-click on the dataset. 
• Choose Select to make 

the dataset available for
processing. A red checkmark
will appear beside the dataset
when it is selected.

UNSELECT
This option will unselect the
highlighted dataset.

UNSELECT ALL
This option will unselect all datasets.

APPLY CONSTANT
To add, subtract, multiply or divide by a constant choose
Apply Constant. You will then be prompted to choose
the appropriate operation and constant. The resulting data
set will be added to the Experiment window.  

ADD SELECTED DATASETS
This option will sum all datasets which are selected. The
resulting dataset will be added to the Experiment window.
Datasets must be of the same type and contain identical
x-axes, as well as the same number of data points to be
added. An error message will be displayed if an
inappropriate data set is selected. 

SUBTRACT SELECTED DATASETS
Choosing this option with two data sets selected will
subtract the second data set from the first. The difference
dataset will be added to the Experiment window.
As with Adding, the datasets must possess identical x-
axes. An error message will be displayed if an
inappropriate data set is selected. 

MULTIPLY SELECTED DATASETS
This option will cause the selected datasets to be
multiplied. The product dataset will be displayed in the
Experiment window. 
The datasets must have identical x-axes to be multiplied.
An error message will be displayed if an inappropriate
data set is selected. 

AVERAGE SELECTED DATASETS
This option will average two or more sets of data with
identical x-axes. The resulting averaged data is added to
the Experiment window.

DIGITAL FILTER
This option allows for a Savitzky-Golay smooth of the
selected data and prompts the user to select from a 3-25
point smooth. The smoothed dataset will be added to the
Experiment window. Note: It is important that care is
taken to avoid over filtering the data.

DERIVATIVE
This option calculates the derivative of the dataset and
adds it to the Experiment window. First through fourth
derivatives are available.

RC FILTER
This option applies a simulated time constant to time
course data. The time constant must be specified (in sec
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DATA PROCESSING

or msec) and cannot exceed the length of the dataset. A
rule of thumb for the maximum time constant without
distorting the data is 5-10% of the total time.
Note: It is important that care is taken to avoid over
filtering the data. 

REVERSE DATA ARRAYS
This option changes the order in which the data is
processed. This has no effect on the data but may be
necessary for performing SVD analysis on some datasets.

AVERAGE SCANS WITHIN A DATASET
This option averages multiple scans within a dataset. The
resulting dataset will be a 2-D dataset added to the
Experiment window.
There is also an option to perform this operation during
data collection. See page 14 for more information on
averaging scans during data collection.

BUILD A 3-D DATASET FROM 2-D
This option will convert all selected datasets to a 3-D
file. The selected datasets must be 2-D, and each dataset
must contain consistent values for Y-axis name, units,
and a value for each scan. 
In addition, the X-axes must be compatible: they must
have the same range and number of data points.
See page 28 for more information on 
changing axis information.

SYNTHESIZE NEW DATASET
This option prepares a synthetic dataset. After selecting
this option enter the relevant information in the prompt
and click on “Synthesize”. The only algorithm currently
available is “linear.”

POLARIZATION
This option converts two selected polarization of
fluorescence spectra to polarization units.
The selected data sets must be one spectra calculated
with a vertical emission polarizer and one with a
horizontal emission polarizer. The resulting polarization
spectrum will be reported in the Experiment window.

ANISOTROPY
This option converts two selected polarization of
fluorescence spectra to anisotropy units.
The selected datasets must be one spectra calculated with
vertical emission polarizer and one with a horizontal
emission polarizer. The resulting spectrum will be
reported in the Experiment window.

CORRECTED SCANS
Choosing this option corrects transmission scans for
intensity variations. To correct a spectrum, transmission
spectra obtained with the beam blocked and beam open
must be selected, along with the spectrum to be
corrected. The resulting corrected spectrum will be added
to the Experiment window.

ASSIGN AS OPEN
Clicking this button assigns the selected scan as the “open”
scan for scan correction. This is defined as a scan with no
sample in the beam and should ideally give 100%
transmission.

ASSIGN AS BLOCKED
This option assigns the selected scan as the blocked scan
for scan correction. This scan is taken with the shutter
closed and should ideally result in 0% transmission.

CONVERT CD UNITS
This option allows circular dichroism spectra to be
converted to other units. The available units are degrees,
millidegrees, absorbance units, milliabsorbance units,
molar extinction, and molar elipticity. 
See Paul’s Practical CD Guide for more detailed
information about circular dichroism units.

NORMALIZE
This button results in division of the selected dataset by
the largest intensity in the dataset. The result is a dataset
which has been internally normalized. This is useful for
comparing shapes of spectra of different intensities.

DILUTION CORRECTION
This option corrects the selected dataset for effects of
dilution and is only available for datasets collected with
an Olis titration accessory.
Each scan is corrected by the factor: 

Vcurrent
Vinitial

where Vcurrent is the total volume of the sample for the
current scan and Vinitial is the starting sample volume.

CONCATENATE
This option allows two selected spectra from assays to be
merged into one dataset. If the datasets overlap, the
software will prompt to either choose a dataset or average
the overlapping datasets.
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DATA PROCESSING AND DATA FITTING

CURRENT VOLTS TO ABS
This function is used to convert a single beam time trace
into an absorbance trace using any region of the curve as
a reference value.

INTERPOLATE
This function is used to change the number of data points
or interval between data points in the selected dataset. A
new dataset range and number of intervals are chosen and
the data is fit by a cubic spline. The new data is
computed and added to the experiment window.

CORRECT FLUORESCENCE SCAN
This function is used to correct a fluorescence scan for
effects of wavelength changes on the sensitivity of the
instrument. A correction file is chosen to be applied to
the data. Contact an Olis representative for more
information on generating a correction file.

FOURIER TRANSFORM
This option performs a fourier transform on the selected
data. This process requires the number of data points to
be equal to a power of 2 (e.g., 572, 1024, etc.). The
option to truncate or interpolate the data is available to
give the correct number of data points.
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Peak Finder
This data process determines
the location of peaks along a
dataset by averaging the slope
in given point counts and
determining when that slope
shifts from positive to negative.

AVERAGE COUNTS
The number of points to be
averaged at a time in order to
calculate the slope of the data is
entered here. Increasing this
number has the effect of
decreasing the sensitivity to sharp
peaks. Thus, a dataset which
contains broad peaks punctuated
by noise would require a relatively
large number of average counts.
Conversely, a small number of
average counts is useful for
identifying numerous sharp peaks.

SLOPE THRESHOLD
This is the criterion for determining if a change in slope
constitutes a peak or noise. The lower this value, the
lower the intensity of the peaks that will be identified.
Typical values will range from 0.01 to 1.

PEAKS INFO
The identified peaks will be listed in this table after the
Average Counts and Slope Threshold have been
accepted.

ACCEPT
Click this button to accept the current Average Counts
and Slope Threshold. This will result in the identified
peaks being reported in the Peaks Info graph.

TOGGLE LABEL
Click this button to add or remove labels for the peaks on
the Peaks Results graph.

DONE
Click this button when you are finished. The peak values
in the Peaks Results graph will be included in the data
set comments, and Peak Finder will be exited.

CANCEL
Clicking the Cancel button exits peak finder without
performing a peak fit.

PEAKS RESULTS
The location of the peaks which are identified are shown
graphically here. The labels can be turned on or off by
clicking on Toggle Label button.

PRINT
Choosing this option prints a report containing the
identified peak values and the graph in the Peaks Results.
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Data Fits Menu
Two or three dimensional
data sets can be fitted 
by one of many mechanisms.

SINGULAR VALUE
DECOMPOSITION (SVD)
Choosing this option initiates
the process of singular value
decomposition (SVD). The
highlighted dataset must be 3D
and contain at least ten points in
each axis.  See the SVD tutorial
in the startup screen  for more
detailed instructions on
performing SVD.

SVD ON DATA SUBSET
This process initiates the SVD
process on only a portion of the
highlighted dataset. The desired data ranges will be
prompted by the program. This option is useful if a
portion of the collected data is unusable or contains little
information.

2D FITS
Two dimensional kinetic data can be fitted by selecting
the kinetic trace by clicking on the curve, and choosing
this option. A list of possible kinetic mechanisms will be
displayed. Choose the appropriate kinetic mechanism,
and the resulting kinetic fit will be added to the
Experiment Window. This window contains kinetic
parameters, residuals, and the calculated data.

COMPTON FIT
This menu item initiates the Compton secondary structure
analysis algorithm for analysis of a protein circular
dichroism spectrum. The highlighted spectrum must be
from 260 nm to 178, 180, 182, or 184 nm and be 2
nm/point.  After this option is chosen, the fit results will
be shown in place of the comments. The fractional
contribution of five secondary structure motifs will be
displayed. These motifs are alpha helix, antiparallel beta
sheets, parallel beta sheet, beta turn, and other structure.
See ‘Paul's Practical CD Guide’ for more information
about the Compton fit.

OLIS DSM CD SOFTWARE MANUAL 25



Edit Dataset
Allows for data to be viewed
in speadsheet form.

NAME
Displays the dataset name. This is
not the filename, and can be changed
without affecting the filename.

PARAMETERS
This contains a list of options to
display in the text box below. The
options are Comment, Date of
File Creation, and Sourcefile
Name. Only Comment can be
edited in Edit Dataset.
All data text can be edited in the
text box; however, only comment
text will be changed upon exit.

AXIS NAME
Displays the axis name, which can be edited. To build 
2-D scans into a 3-D scan they must have the same axis
names in all axes.

AXIS UNITS
Displays the axis units, which can be edited. To build 2-D
scans into a 3-D scan they must have the same axis units
in all axes.

NUMBER OF POINTS
This reports the number of points along this axis. This
value cannot be edited. Rows or columns can be deleted
as described in “Remove Column” and “Remove Row.”

START
Indicates the value of the first data point along this axis.

STEP
Indicates the interval between data points if the axis is
linear (i.e., has equal spacing between points).

IS LINEAR
Indicates whether there is equal spacing between points
along an axis. If Is Linear is “Yes” then the axis can be
described by the number of points, start, and step. 
Value=Start+(N-1)*Step, where N is the current 
data point.

EDIT AXIS DATA
Clicking on this button allows the X or Y axis data to be
changed.
See page 28 for more information on
the Edit Axis Data window.

ADD COLUMN
Use this button to add an additional column (Y data
point) to the end of the dataset. To enter the Y value,
choose Edit Axis Data.
See page 28 for more information on
the Edit Axis Data window.

REMOVE COLUMN
Use this button to remove a column from the end of the
dataset. To remove a column or columns other than the end
column, select data to be removed, right-click on the data,
select Axis Options, and choose Remove Axis Point(s).
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EDIT DATASET

ADD ROW
Use this button to add an additional row (X data point) to
the end of the dataset. To enter the X value, choose Edit
Axis Data. Enter or paste data using cut and paste.
See page 28 for more information on
the Edit Axis Data window.

REMOVE ROW
Use this button to remove a row from the end of the
dataset. To remove a row or rows other than the end
column, select data to be removed, right-click on the data,
select Axis Options, and choose Remove Axis Point(s).

CELL CONTENTS
This box displays the contents of the selected cell. Data
can be edited in this box. Pressing the Enter key or
clicking on another portion of the screen will enter this
data in the dataset.

X-AXIS
Data in the first column constitutes the X-axis of the
dataset. This data can be edited by clicking on Edit Axis
Data in the X-axis window.
See page 28 for more information on
the Edit Axis Data window.

Y-AXIS
Data in the first row constitutes the Y-axis of the dataset.
This data can be edited by clicking on Edit Axis Data in
the Y-axis window.
See page 28 for more information on
the Edit Axis Data window.

EXPAND DATA
Clicking on this button enlarges the data window to fit
the entire Edit Dataset window. Clicking on Shrink
returns to the original condition.

POST DATA TO GLOBALWORKS
Clicking this button stores the data in the Experiment
window as a new dataset. The dataset can be saved,
viewed in the chart window, fit, or discarded.

CANCEL
Quits Edit Dataset without saving any changes.
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Edit Axis Data
Allows axis values 
to be changed.

CUT
Copies selected data to Windows
clipboard and deletes it from the
dataset. The data are then
available to paste into other
Windows applications.

COPY
Copies selected data to Windows
clipboard without removing it
from the data set. The data are
then available to paste into other
windows applications.

PASTE
Inserts data from wWndows clipboard into selected data
window. This will overwrite any data that are already
present.

SELECT ALL
This option selects the entire dataset.

AXIS OPTIONS
This option allows the selected data to be deleted. This
option is only enabled while in Edit Axis Data.

SAVE AXIS DATA
Clicking this button will save any changes made to the
axis data and return to the full data set view. This must be
done before clicking Post data to Globalworks if
changes in axis data are to be retained.

CANCEL AXIS EDIT
This button returns the Edit Dataset form to the full data
view without saving any changes made to the axis.

28 OLIS DSM CD SOFTWARE MANUAL



Temperature Controller
Provides software control 
for Olis-compatible
temperature controllers.

TEMPERATURE
CONTROLLER TYPE
If the instrument is equipped with
more than one type of temperature
controller, the active temperature
controller is chosen here. The current
choices possible are Quantum
(Peltier controlled cell) and Julabo
(water bath). Only one choice will
be available if the instrument is only
equipped with one.

SAMPLE HOLDER
TEMPERATURE
This is the current reading of the sample holder and is
only updated if the instrument is in Live Mode. With the
Peltier (Quantum Northwest) this temperature represents
than inside the cell holder. In the case of the water bath
(Julabo), this temperature is the temperature of the bath.
See page 8 for more information about Live Mode.

HAS EXTERNAL PROBE
This checkbox indicates whether the temperature
controller is equipped with an external temperature
probe. This probe would be inserted into the cuvette
holder, or into the sample itself, to give a more accurate
temperature reading of the sample. An additional field
will report the probe temperature.

ON/OFF
This switch controls whether the temperature controller is
active. If Off is selected, no communication will be
attempted between the software and the temperature
controller. If On is selected the temperature controller
unit must be on, or errors will result.

SET TEMPERATURE
This is where the set point temperature on the bath or
Peltier cell is set. The temperature should immediately
approach this value if the controller is active. The only
time this is not the set point is when a temperature script
is being run.

WINDOW OF TOLERANCE
The window of tolerance is the range of temperatures in
which the current temperature is equal to the set point
temperature. For example, if during the running of a
temperature script with the current temp set at 40°C and a
window of tolerance of ±1°C, the set temperature will be
achieved when the current temperature reaches 39-41°C.
The actual temperature, however, will be recorded with
the data.

TEMPERATURE UNITS
Only Celsius units are available.
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Titrator Control Panel
Allows for software controll of
the Olis titrator. Access to
this screen is in the repeated
scans page.

SCRIPT FILE
This designates the current script
file name. It is identical to that
shown in the Repeated Scans tab.
See page 13 for more information
on the Repeated Scans tab.

EXECUTE LINE
Click on this button to execute a
line of the script without collecting
data. The software will prompt for
which line to execute. The
syringes will move, but no data
will be collected.

EXECUTE SCRIPT
Click on this button to execute an entire script without
collecting data. The syringes will move, but no data will
be collected.

SELECT SCRIPT
This button allows the user to select a valid titration
script. Changes in the script in this window will change it
in the others as well.

See page 31 for a sample titratrion script file.

VIEW/PRINT SCRIPT
This button allows the user to open the script for editing
or printing. Note: Do not attempt to change the "Default
Titrator.osf" script as it is a read only file and is
necessary as a backup script file.
See page 14 for details on editing script files.

COM PORT NUMBER
Ensure that this number matches the com port number
that the titrator is actually using.

SYRINGE SIZE (uL)
Ensure that the syringe size in this display matches the
actual syringe size for the selected syringe.
To select a syringe, click on the desired syringe in Syringe
Control. The text box below the syringe will become
yellow, indicating it has been selected. Changing the
syringe size changes the size of only the selected syringe.
Syringes are selected using the Syringe Control.

CALIBRATE SYRINGE
These buttons initiate a calibration procedure. During
calibration, the syringe fills completely until a sensor is
reached, whereupon the syringes empty. It is important to
have the valve in “Fill” position and have enough sample
in the fill syringe. If samples are precious, it is important
that calibration is done using water or buffer.
Calibrate Selected only calibrates the selected syringe,
while Calibrate All initiates the calibration procedure for
all syringes.
Syringes are selected using the Syringe Control.
The keystroke shortcuts for Calibrate Selected and
Calibrate all are S and A, respectively.
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TITRATOR CONTROL PANEL AND SAMPLE TITRATION SCRIPT

PARK SYRINGE
When one of these buttons is pressed, on or more of the
syringes fills or empties to half full.

Park Selected parks only the selected syringe, while
Park All moves all of them.
Syringes are selected using the Syringe Control.

RINSE SYRINGE
Rinsing syringes involves alternating filling and
emptying them. When clicking on of these buttons, the
software will prompt to ask the number of desired rinses
(1-99). It is important to have the valve in “Fill” position
and have enough sample in the fill syringe.  If samples
are precious, it is important that calibration is done using
water or buffer.
Rinse Selected rinses only the selected syringe, while
Rinse All initiates the procedure for all of them.
Syringes are selected using the Syringe Control.
The keystroke shortcuts for Rince Selected and Rinse all
are R and N, respectively.

FILL SYRINGE
These buttons cause syringes to completely fill. It is
important to have the valve in “Fill” position and have
enough sample in the fill syringe. If samples are precious, it
is important that calibration is done using water or buffer.
Fill Selected rinses only the selected syringe, while Fill
All initiates the procedure for all of them.
Syringes are selected using the Syringe Control.

EMPTY SYRINGE
These buttons cause syringes to completely empty. It is
important to have the valve in the desired position so
the contents of the syringe are not inappropriately
expelled. If samples are precious, it is important that
calibration is done using water or buffer.
Empty Selected rinses only the selected syringe, while
Empty All initiates the procedure for all of them.

SYRINGE CONTROL
This control allows the user to manually manipulate the
syringe volume. The current volume is displayed in the
box at the bottom of each virtual syringe. This volume
can be changed by entering in a new value (in uL) or
dragging the sidebar control to the desired approximate
volume. Filling of the syringe is graphically illustrated
by the blue shading. To select a syringe, click on the
body of the syringe. A yellow text box will indicate that
the syringe is selected.

Sample Titration Script
[Type]

Titrator

[Comment]

Comment Section.

Any amount of text and/or white space may be put into the Comment
Section.  Any comments outside of the comment section (line
comments) MUST be preceded with a semi-colon, and all text
following a semi-colon on a single line is ignored.
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Scriptfiles are divided into different sections by section headers
(header names enclosed in square brackets).  Section headers must
start in the first column, and no other data, including comments,
can follow them. Different types of scripts will contain different
sections. The only sections guaranteed to be in every script file
are Type and Scans. A comment section is optional but can also be
placed in any script file.

[Scans]

10 ;Number of scans/assays to take

[Cuvette Volume]

;This is the volume (in uL) that is put into the cuvette to make
;the measurement

500

[Starting Volumes]

;   Syringe

; 1    2  

1000 1000 ;These are the volumes (in uL) that will be drawn into 
;the syringes prior to the beginning of data collection.
;You must supply a volume for each syringe to be used 
;and this volume must  equal to or greater than the sum
;of all additions to be made from each syringe and less
;than or equal to the maximum volume of the syringe.

[Scan Data]

;Data for each scan consists of Titrant to be added (in uL),
;Incubation time (in minutes) and mix cycles. There is always at
;least one mix cycle, any specified here are in addition to the
;mandatory one mix cycle.
;  Titrant Incubation Mix Cycles

50 1 1
50 1 1

100 0 0
100 0 0
100 0 0
100 0 0
100 0 0
100 0 0
100 0 0
200 0 0

SAMPLE TITRATION SCRIPT

32 OLIS DSM CD SOFTWARE MANUAL



Sample Temperature Script
[Type]

Temperature

[Comment]

Comment Section.

Any amount of text and/or white space may be put into the Comment
Section.  Any comments outside of the comment section (line
comments) MUST be preceded with a semi-colon, and all text following
a semi-colon on a single line is ignored.

Scriptfiles are divided into different sections by section headers
(header names are enclosed in square brackets).  Section headers
must start in the first column and be alone on the line.  Different
script types will contain different sections.  The only sections
guaranteed to be in every script file are Type and Scans.  A comment
section is optional but can also be placed in any script file.

[Scans]

10 ;Number of scans/assays to take

[Scan Data]

;Data for each scan consists of a temperature (in degrees C) and
;an incubation time (in minutes) for the machine to wait before 
;collecting data after the temperature control device has reached
;the desired temperature.

;   Temp Incubation

20 1

25 0

30 0.5

35 2

40 0

45 1

50 0

55 0

60 0.5

65 0
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Appendix I: Glossary of Terms
CD
Circular Dichroism.

DSM
Digital Subtractive Method.

COMPTON FIT
This is a protein secondary structure estimation
based on the algorithm of Compton and Johnson.
This requires data from 260 nm to 178-184 nm
wuthg a span of 2 nm per point. The output will be
relative percentages of  -helix, parallel  -sheet,
antiparallel  -sheet,  -turns, and other structures.

HV
High Volts.

IDLE MODE
In idle mode the instrument is not collecting data.
PMTs will be off unless the instrument is in manual
high volts mode. In idle mode and PMTs off, it is
safe to make hardware changes such as changing
sample chamber modifications.

LIVE MODE
In this mode, the instrument is collecting data and
displaying the results in the Live Display tab.
Readings are continuously updated but not recorded.
This mode is useful for checking CD intensities prior
to a scan.

PARK SYRINGES
We "park" syringes in order to manipulate them. That is,
they are not in empty or full position, but exactly
midway, "parked" in the middle.

PMT
Photomultiplier Tube.

POST DATA
We refer to "posting data to RAM," as opposed to
"saving data to disk." That is, the data are posted in
anticipation of further processing and/or storage

SLICE
A slice refers to a 2D data trace within a 3D dataset. For
example, the 3rd scan of a 10 scan dataset. Or the kinetic
trace at a specific wavelength. The term ‘slice’ can also
refer to a 2D dataset.

SVD
Singular Value Decomposition.

3D
Three Dimensional.

2D
Two Dimensional.
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Appendix II: Administration Form
Every Olis instrument uses a parameters.xml file to store information. This file is located in the Olis
Globalworks\ParaXML\ directory. Included in this file are all of the necessary information for the
Spectralworks program to operate your instrument. These include calibration numbers, number of detectors,
number of monochromators, number of accessories, delay times, and previous instrument settings. This is an
important file and the instrument will not run correctly if this file is corrupted. Because of this, you should not
edit this file directly unless directed to do so by Olis. There are some values of this file, however, that you
may need to access occasionally. This can be achieved from the data collection program by simultaneously
pressing ‘Shift’+’Ctrl’+’Alt’+’a’ to open the administration form. This form is divided into several links, each
of which contains information about a device on the instrument. For example, clicking on the
‘Monochromators’ link contains information such as calibration wavelength, motor delay, and motor direction
for the monochromators. Use extreme care in editing this form as hardware damage can result from running
the instrument with incorrect settings. The following table describes some parameters which may at one time
or another be changed.

PARAMETER LOCATION (LINK) DESCRIPTION

Com Port Number Master Control Box Declares the computer com port number 
that is used by the electronics box. This must be
changed if a different com port is used.

Number of Com ports 
on this computer

Master Control Box Declares the number of available Com Ports on
the computer

Calibration wavelength Monochromator Determines the wavelength assigned to the
sensor position on the monochromator. This
should be adjusted if the wavelength is believed
to be off.

Stop Adjustment time PCI416 An adjustment to the time in which the stopped
flow calls zero time. The units are milliseconds
after the stop syringe has stopped. This should be
adjusted if the zero time of the stopped flow
reaction is not correct.

A/D sampling rate PCI416 The rate in which the A/D board streams in data.
The upper limits are 2 and 1 MHz for 12 and 14-
bit A/D boards, respectively.

Number of Points 
(Stopped flow)

PCI416 The number of points after zero time for stopped
flow. This value is typically about 1000.

Response delay time PMT This is the time the instrument waits after turning
on (or changing HV) a detector before 
collecting data

Integration Constants Low 2 DCGUI Integration constants 1 and 2 are used in
calculating the integration time as a function of
PMT HV.  (I1)e(HV/I2)=Int Time

These are typically 0.3 and 160.

Phase Adjust PCIY16 Adjusts phase of detection of CD signal
respectively and will affect amplitude and sign of
signal if not correct.
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